
Microsoft Power Point 2013 
 

 

             Definition: 
 

Power Point is a presentation program that allows you to create dynamic 
slide presentations. These presentations can include animation, narration, 
images, videos, and much more. 

 

 

 

Starting Microsoft Power Point 

               To open Microsoft Power Point: 

1. Click on the Start button and choose All Programs. 

2. From the sub-menu choose Microsoft Office 2013. Then Power Point 2013. 

Below this is the Ribbon, with tabs along the top. Each tab has a set of icons       which 

are used to give instructions to Power Point called Groups. 
 

The Power Point interface 
 

When you open Power Point for the first time, the Start Screen will appear. 

From here, you'll be able to create a new presentation, choose a template, 

click Blank Presentation to access the Power Point interface.  
 
 
 
 
 
 
 
 
 

 



      

    
   

 
 

 

Working with the Power Point environment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Quick Access Toolbar: In the top left corner of the screen 

is the Quick Access Toolbar which contains icons to 

common commands, e.g. save and undo. 
 

Ribbon: with Tabs along the top. Each Tab has a set of icons called 

commands which are used to give instructions to PowerPoint called Groups.  
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FILE  Commands related to managing files, such as Open, Save, and 

  Print; and various PowerPoint options and settings. 

HOME The most commonly used commands for developing presentations, 

  such  as adding  and editing text, and inserting slides. 

INSERT 

 

Commands for adding and working with a variety of objects, such as 

  charts, tables, and images. 

DESIGN 

 

Options for tailoring the overall visual design of your presentation. 

 

TRANSITIONS Options for creating visually appealing transitions. 

 

ANIMATIONS Commands to add and edit animated effects in your presentation. 

 

SLIDE SHOW The functions you will use to deliver your final presentation. 

 

REVIEW Options for reviewing and revising the content in your presentation. 

 

VIEW Commands to modify how you view your presentation.  
 

 

Left pane: focuses on the content of your presentation rather than its appearances  

 

Slide Pane: display the slide you are currently working on. 
 

 

Status Bar: At the bottom of the window, can display various 

information, such as slide number, language you’re working in etc. On the 

right-hand side of the Status Bar are icons to change the view of the slides 

and to zoom in or out. 
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Creating a New Presentation 
 

1. Double click to Microsoft Power Point 2013  
2. Choose Blank Presentation, Or Choose a theme. 

 When you open Power Point, you’ll see some built-in themes and templates. 

A theme is a slide design that contains matching colors, fonts, and special 

effects like shadows, reflections, and more. 

 

            Click Create, or pick a color variation and then click Create. 
 

 

 

You are ready to enter information onto your first (title) slide. If necessary, 

(Maximize) the window to fill the screen. The main part of the screen is divided 

into two sections. The main section shows the current slide, while on the left, 

slide miniatures appear, allowing you to see the current slide in its context. 

 

It's important whenever you create a presentation that you give full consideration 

to your audience. In particular, don't try to crowd too much information on each 

slide and make sure that the text is big enough to be clearly readable.  

Entering Text onto the First Slide The first slide has the layout for a Title Slide 

(usually you start a presentation with a title slide, though you don't have to). The 

layout has two boxes with a dotted frame. 

magnification using the zoom facility in the bottom right-hand corner of the Status Bar. 
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Use the slider or click on the [Zoom level] (%) button. 

 

 

Adding New Slides 

To add the next slide: 

1. Click on the [New Slide] button on the left of the HOME tab in 

the Slides group (click on the icon not on the words New Slide) 

Tip: You can jump between placeholders by pressing on the 

keyboard; if on the last placeholder it creates a new slide. 

 
2. Or click the right mouse button on the current slide, select New 

Slide. 
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3. Or by the shortcut keyboard Ctrl + M . 

4. A new slide appears in a different slide layout from the first called 

Title and Content. There are several different slide layouts 

available (which you can get to if you click on the words New Slide 

rather than the icon). 

There are a number of ways that you could change the look of your text on 

this slide. You could, for example: 

• Change the bullet point character 

• Use a different font 

• Change the font color 

• Change the case (upper, lower) of the text 

• Increase or decrease the line spacing between the bullet points 
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1. On the HOME tab in the Paragraph group, click on 

the down arrow next to the [Bullets] button 

2. Choose the bullet character required (e.g. the tick marks 

or checkmark bullets) 

3. To use a different font: Click on the down arrow next to 

[Font] button on the HOME tab, and choose the font 

you want (e.g. Arial) are best. 

4. to change the font color: Click on the down arrow next 

to [Font Color] button in the Font group, Click on the 

square of the color that you want (or click on More 

Colors… and select a color from there then press for 

[OK]) 

5. To change the case of the text, eg turn all the letters to 

UPPERCASE or to lowercase: Click on the [Change 

Case] button in the Font group and choose the case 

required . 

6. to change the line spacing of the bulleted points: Click 

on the [Line Spacing] button in the Paragraph group on 

the HOME tab, Choose the line spacing required, e.g. 

1.5 for one and a half line spacing. To change the spacing 

before or after a paragraph. 

 
7. [Format Painter] (The paint brush icon in the 

Clipboard group on the left of the Home tab) to copy 

the 

format of one list entry to 

another (or to the whole 

list). 
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Save your presentation file 
 

In Power Point 2013, you can save your desktop presentation in 

different file format. 
 

1. On the File tab, select Save.  
select 
Computer

.  
2. Select 
Browse, pick a path 
and file folder.  
3. Enter the file 
name in File name box. 

4. Select Save.  
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Save your presentation file in a different file 

format or in different location in the computer: 
 

1. On the File tab, select Save As.  
2. select Browse, pick a path and file folder, and then name the 
file.  
3. In the Save as type list, pick the file format that you 
want. To save files in PDF format (.pdf) for a non-editable copy. 

4. Select Save. 
 

Save your presentation in an earlier version of Power Point 
 

In Power Point 2013, you can save files to an earlier version of 
Power Point by selecting the version from the Save as type list 

in the Save As box. For example, you can save your Power Point 
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presentation in the newest Power Point Presentation format 
(.pptx), or as a Power Point 97-2003 Presentation (.ppt). 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Closing the Presentation  
 

To close the Power Point presentation file: 
 

 
Click on the File tab and select (Close) 

button. 

 

Or from the upper – right corner of the 

window click X tool.  
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Tabs The Ribbon 

HOME Tab contents in ribbon 

 

HOME Tab contains Clipboard, Slides, Font,……… 

 

 
 

 
INSERT Tab contents in ribbon 

 
INSERT Tab contains New slide, Table, Image,…. 

 

 
 

 
DESIGN Tab contents in ribbon 

DESIGN Tab contains Themes, Variants,…. 
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TRANSITIONS Tab contents in ribbon 

 
TRANSITIONS Tab contains Transilation This Slide, Timin,… 

 

 

 

 

ANIMATIONS Tab contents in ribbon 

ANIMATIONS Tab contains preview, Animation,…. 
 

 

 

 

 
 

 

 

SLIDE SHOW Tab contents in ribbon 

 

Slide show contains Start slide Show,… 
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The elements of a slide   
 
 

   

   
   

 

Layouts: 
 

Is a shortcut that allows you to choose how you want your information 

or image to be arranged in the slid. A layout contains placeholders, 

which in turn hold text such as titles and bulleted lists and slide content 

tables, charts, pictures, shapes, and clip art. 
 

The following some types of slide layout: 
➢

Title slide  
➢

Title and content 
➢

Two content 
➢

blank 

➢
Comparison 

 
 
 
 
 
 

 

Placeholders: 
 

Is a location on the slides where 

information to be entered for example 

enter text or insert an element, such 

as a picture, chart or sound clip and 

bulleted lists. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Placeholder 
 

 

  

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/ppmain10.chm::/html/AboutLayouts.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/ppmain10.chm::/html/AboutLayouts.htm
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/ppmain10.chm::/html/AboutLayouts.htm
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Changing the Theme 
 

Themes, like slide masters, should always be used when developing 
more advanced presentations. Within a theme, you can change the 
colors, fonts and effects that are used.  

Each color theme is a palette of 8 colors which are used for 

particular elements in your presentation - e.g. the background, text 

and hyperlinks. Rather than change a color for particular elements on 

each slide or on the Master Slides, you should reset it in the color 

theme - it is then applied to all your slides and Masters automatically. 

 

You will find that different themes have different pre-defined color 
themes:  

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

1. Move to the DESIGN tab – the ribbon changes to show a number of 
different themes.  
2. To the right of the themes is the Variants group – move the mouse 
over the various color themes to see a preview of them.  
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Animating your Presentation 
 

Presentations are greatly improved by adding animation. PowerPoint 

gives you a wide selection of built-in animations, both when moving between 

one slide and the next and within each slide. Slide Transitions Instead of simply 

moving abruptly from one slide to another during a presentation, 
 

Slide Transitions 
 

Allow slides to dissolve into each other, using a variety of different 

special effects. These can make your on-screen presentation look even better 

and more professional: 
 

1. Check you are in Normal view and that the first slide is selected 
 

2. Move to the TRANSITIONS tab to see the following ribbon: 

Dominating the ribbon is the Transition to This Slide group. As you click on an 

icon, you’ll see the transition effect on the slide (there is also a More arrow that 

will show you all the different transition effects in one window).  
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[Effect Options] button lets you change the direction of the effect. 

Timing (the group to the right) lets you change the speed of the 

transition effects. 
 
 

 

3. Choose one of the transition effects for the first slide (the [More] 

button  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

shows all the effects) Note that a small star symbol appears to 
 

the left of the first slide miniature - this indicates that a transition 

has been setup on this slide. 
 
 

 

4. Click on [Effect Options] and change the direction of the effect 
 

5. Increase the Duration: of the transition to slow it down and see 

the effect more clearly. You can also set up a Sound.  
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6. Under Advance Slide, set the next slide to appear after: a set 

number of seconds 
 

7. Move to the next slide and repeat steps 3 to 6, choosing different 

effects 
 

8. Finally save your presentation then run it to see the effects. 
 

9. Click on [Apply to All] 
 
 

 

Animation Schemes 
 

Power Point allows information on your slides to appear one 

item at a time. This stops your audience from reading ahead of 

you, making them concentrate on each point individually. 
 

1. Move to the ANIMATIONS tab then click on a slide with a 

bulleted list on it (e.g. slide 2) 
 

2. Click on the bullet points then move the mouse over the 

Animations icons and watch the effects 
 

3. Click on the [More] button at the foot of the Animations scroll 

bar to see more animations:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4. From the list of animations choose one of them, e.g. Fade 
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5. Click on [Effect Options] (if active) and see what is available 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

6. Repeat steps 3 to 5 for another slide with bullet points, 

choosing a different animation 
 

7. Click on the slide title on one of the slides that you’ve already 

animated 
 

8. Next, click on the [Animation Pane] button in the Advanced 

Animation group to display the task pane Currently, the title (and 

picture) isn’t animated. To add animation: 
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9. Click on the [Add Animation] button and choose an Entrance 

animation  
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10. Click the <▲> button (or on [Move Earlier] in the Timing 

group) to animate it before the list 
 

11. Select the title again and this time [Add Animation] 

choosing an Emphasis animation 
 

12. Repeat step 10 to move it to second in the list 
 

13. Click the [Play From] or [Preview] button to view your changes 

 

14. Next, try animating the picture, displaying it after the title 

animations 
 

15. Finally, save your presentation (press <Ctrl s>) then run it from 

the first slide (press <F5>). 
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Power Point Views 
 

It is possible to view your presentation in a number of different ways.  
To switch between views: 

 

• Either: Move to the VIEW tab and choose one of the icons in the 
Presentation Views group  

 
 
 
 
 
 
 
 
 
 

 

• Or: Use the buttons at the bottom right of the window (just to the left of 
the Zoom options)  

 
 
 
 
 
 
 

 

There are 4 different view buttons give you:  

• View on Screen Use to Normal View Shows the slides in miniature 
and in full, plus any notes underneath Edit contents of slides; try out 
animation effects.  

• Slide Sorter Shows a miniature of each slide in the current order Add, 
delete and move slides; rehearse timings Reading View Plays the 
presentation on screen from the current slide Practice presentation and 
have access to other tasks. 
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• Slide Show Plays the presentation on screen from the current slide 
Practice presentation, or from the Beginning.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

From the View tab on the Ribbon, there is also the following option 
(instead of Slide Show): 

 

• Notes Page gives a view with more space for speaker's notes under the 
slide. Here, you can type up exactly what you plan to say for 
each slide. The notes can then be printed out so you have them 
to consult when giving an actual presentation Note: 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The [Reading View] icon here plays the presentation from the very beginning. 
Moving through the Slides 
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There are several ways to move between slides, when preparing a 
presentation in Normal view:  

• Click on the required slide miniature in the left-
hand section of the screen  

• Use the scroll bar on the right of the main display - 
drag the indicator up or down (the current slide 
details are displayed as you do so)  

• Use the double arrow buttons ([Previous Slide] and 
[Next Slide]) at the foot of the scroll bar 

 
 
 
 

 

Deleting and Hiding Slides  

It's easiest to delete slides in Slide Sorter view (though you can also do so 
in Normal view), especially if you have a lot of slides to deal with:  

1. Click on the [Slide Sorter] button (either on the Status Bar or VIEW 
tab) 
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2. Click on the slide to be deleted 
then press the <Delete> key 

 

To reinstate the deleted slide, press <Ctrl z> for Undo. 
 
 
 
 
 
 

When a slide is hidden it remains within the Power Point file, 
but is not displayed during the presentation.  

To hide a slide:  

Right click on the slide to be hidden (in Normal View you have to 
right click on the slide miniature)  
From the shortcut menu choose Hide Slide - you’ll find that the number 

underneath the slide now has a line through it indicating that it’s hidden  
 
To show the slide again, just repeat the steps to display a hidden slide. 

 

Changing the Order of Slides 
 

The easiest way to move slides around is within Slide Sorter view:  

1. Make sure you are in Slide Sorter view  
2. Point to the slide you wish to move then hold down the 
mouse button and drag the slide to the new position 

3. Release the mouse button when the slide is correctly positioned 

 

Note: In Normal view you can change the order by moving 
(drag & drop) the slide miniatures up and down the left panel.  
 
 
In both views, you can also cut and paste slides via the 

Clipboard. 
 
 
 

Running the Presentation 
 

Once you have made the slides for a presentation, you can 
run the show. If you use the (Slide Show) or press (Shift+F5) 

buttons on the Status Bar then it begins from the currently-
selected slide; if you press then it starts from the first slide. On 

the SLIDE SHOW tab you can choose from either (From 
Beginning) or (From Current Slide). 
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• Duplicate slides: If you want to copy and paste a slide quickly, you  

can duplicate it. By: 

1. select the slide you want to duplicate 

2. right-click the mouse, and choose Duplicate. 
 
 

 

• Move slides: To change the order of your slides. Just click, 
hold, and drag the desired slide in the Slide Navigation pane 

to the desired position. 

 

 

•Copy and paste slides  

  
1. Select the slide you want to copy in the Slide Navigation pane, then Right 

click
→

copy . 
 

2. In the Slide Navigation pane, click below a slide (or between 
two slides) to choose a paste location. A horizontal insertion 

point will appear.—Right click
→

 Paste 

 
 

Insert Tab 

 
 

You can insert a picture from a file on your computer onto any slide. 

Power Point even includes tools for finding online pictures and adding 
screen shots to your presentation. 
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Insert picture 

  
To insert a picture from a file:  
Select the Insert tab, then click the 
Pictures command in the Images group.  
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

To insert a shape 
 
from Insert tab, click the Shapes command in the 
Illustrations group. A drop-down menu of shapes will 
appear. 
  



3 
 

 

Transitions 
 
 

There are three categories of unique transitions to choose 

from, all of which can be found on the Transitions tab:  
 

• Subtle 

• Exciting  
• Dynamic Content 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

To apply a transition:  
 
Click the slide from the Slide Navigation pane.-->Click 
Transitions tab--Click the More drop-down arrow. 
Click a transition to apply it to the selected slide. 
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You can use the Apply To All command in the Timing 
group to apply the same transition to all slides in your 
presentation.   

 
 
 
 
 
 
 
 
 
 
 

 

 

  To preview a transition:  
Click the Preview command on the Transitions tab.  

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

Modifying transitions 

 
Select the slide.Click the Effect Options command, and 
choose the desired option.  

      

   Add sound to transition   
Select the slide. Click the   Sound drop-down menu in the 
Timing group. Choose the sound.  
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To remove transitions 
 
Select the slide. Choose None from the Transition to This Slide 
group.  
To remove transitions from all slides, apply the None transition 

to a slide, then click the Apply to All command. 
 
 

 

Advancing slides: Move to the next slide after a certain 

number of seconds 
 

To advance slides automatically: 

1. Select the slide.  
2. Go to the Timing group on the 
Transitions tab. Under Advance Slide, 
click on the box next to On Mouse 
Click.  
3. In the After field, enter the amount of time you want 

to display the slide. 

 

4. Select another slide and repeat the 

process until all the slides have the 
desired timing. You can also click the 

Apply to All command to apply the same 

timing to all slides. 
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Internet 
 

A network of computers around the world. Internet is a system of 

connected computers that allows your computer to exchange data, 

messages and files with any of the millions of other computers, which 

have connections to the internet. Internet started in USA 1957 for military 

just over 30 years ago. In 1990s, a simplified way of connecting to 

remote computers by using Hyper Text. You can click on a special text to 

gain information. The technique of internet is Clint-Server structure. This 

technique used to exchange the information. The server is hardware and 

software and process the services from Clint. The Clint is hardware and 

software and takes the services from server. Internet used to sent or 

receive the E-mail, to get the information, to chat with people, to read the 

news, to get the researches or programs and used the games.    

 

World Wide Web (www) is collection of web pages and related 

resources, which are linked together across the internet. 

 

Protocol is a set of instructions or commands that is used to communicate 

or transfer data between the computers that are connected to the network 

in general. For example, (http), (ftp) and  (IP). 

 

Hyper Text Transfer Protocol (http): a protocol that allows text with 

links to be transmitted from computer to computer. 

 

File Transfer Protocol (ftp): is an internet software tool for transferring 

files from one computer to another. The process of transferring a file 

from a network computer to your local computer is called downloading.  

The process of transferring a file from your local computer to a network 

computer is called uploading. 

 

Internet Protocol (IP): is an internet software tool for transferring files 

among the computers.  

 

Networks: the networks are group of computers. The computers linked 

by LAN cards, ports and wires. The cards and ports used to receive and 

sent the information.  
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Types of Network According to their Geographical Distance  

 

1- Local Area Network (LAN): it is the number of computers that 

are linked together by cables in a limited area (a building or group 

of nearby building). 

2- Wide Area Network (WAN):  it is the number of computers that 

are linked together by cables over a large area. WAN used to 

connected offices of an organization that are located in different 

cites in the same country or in different countries for example, 

Internet is WAN network.  

 

Hyper Text Markup Language (html): a set of formatting commands   

to create a web page with text or pictures. 

 

Search Engine: is a program that helps you finding information on the 

internet. It stores listing of web sited from all over the world and make 

them easily available for example, Yahoo, Google,… 

 

Hyper Text: it is a piece of text that can perform an action when the user 

clicks on it. When the mouse pointer changes to the hand with the 

pointing finger, which means that you are on hyperlink. 
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Internet 
 

 

 

Web Site: a computer storage area that contains one or more web pages. 

The web pages linked by hyperlink. The pages have web address. This 

address used to browse contents of site.   

 

 

Web Address 

 

The web address is similar the post address. Each web site has web 

address. The address called uniform resource locator (URL). URL used to 

access a web page and to distinguish web pages from each other. The  

uniform resource locator contains four parts as follows: 

1- protocol name as http:// 

2- www  

3- name of place. This place stored web site. 

4- The fourth part contains two parts. First, represent the name of 

organized. The name of organized has three characters as (com) is 

commercial or (edu) is educational. Second, represent the name of 

country.  The name of country has two characters. 

 

For example, http://www.mohesr.gov.iq 

 

How You Can Search in Internet 

 

1- Open the Explorer or double click on   icon. 

2- Open search engine as Google by writing http://www.google.com 

in address bar.  

3- Print key words in text box. 

4- Press on search. Search engine gives several lists of information 

about key word. This information is hypertext and has several 

pages about key word. 

 

 

 

http://www.yahoo.com/
http://www.google.com/
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Electronic Mail 

E-mail is a program that enables you to transmit and receive messages 

over the internet. A message sent over a network with high speed and low 

cost. You can edit, update and retransmit the same message.   

 

E-mail Characteristics  

 

1- Fast and cheap. 

2- Can be sent to an individual or a group. 

3-You can send text, sound, images and spreadsheets files as attachments. 

 

E-mail Address Characteristics 

 

1- E-mail address is usually written in small letters. 

2- E-mail address does not contain any spaces. 

3- The @ symbol connect a user’s name with domain name. 

4- The part of an address before @ cannot be same for two persons.  

For example, nursingcollege2000@yahoo.com 
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E-learning 

With the spread of modern means of communication, the concept of E-

learning has spread, which means education using modern means of 

communication, from a computer, a network, the Internet, and media such 

as audio, image and video, whether in class or distance education, with less 

time and effort, and greater benefit in an environment far from the teacher. 

Types of E-learning 

  Synchronous 

It is the education in which the student is in front of his through rooms to 

be discussed directly and the teacher at the same time in front of the 

electronic screens, where the student gets nutrition and the most 

characteristic of this type of education is that it saves the time of going to 

the place of study with the availability of a computer and other electronic 

devices 

Asynchronous 

Which does not need the student and the teacher to be in front of the screens 

at the same time, which is E-learning. Communication is through social 

media programs, and the student can return to the scientific material at any 

time he wants. 

Benefits of E-learning 

   Increases opportunities for students to communicate between them and 

the teacher. 

  It provides an explanation of the educational material and can be referred 

to at any time. 

It gives a feeling of equality among all students. 

Cloud Computing 

The term cloud computing began to be used in the nineties, but in practice, and 

in the 2000s, this term became actual, when Microsoft expanded the concept of 

using software through the web, but Google played an important role in the 

field of cloud computing and launched many services. The term cloud 

computing was inspired by the symbol cloud which was often used to represent 

the internet and its applications. 
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Cloud computing concept 

Cloud computing is a sophisticated technology that relies on transferring 

data processing and computer storage space to the so-called cloud that is 

accessed via the Internet, which is a server device that is accessed via the 

Internet, so that information technology programs are transformed from 

products to services. The traditional computing that we use requires the 

presence of all data, programs and applications, while in cloud computing, 

the user may not need to store all the programs, but rather some of them. 

   The cloud computing service allows the user to access all his files anytime 

and anywhere via the Internet. 

Cloud computing lowers cost It is no longer necessary to buy a computer 

with specifications in terms of memory and speed. Take advantage of the 

infrastructure provided by cloud services while ensuring that the service 

works permanently. 

Benefits and advantages of cloud computing 

Encouraging cooperation, communication and interaction between users. 

Better performance by not downloading programs or files on personal 

computers and reducing the cost of classic paper materials while not 

downloading programs or files on personal computers . 

Keep records and access files from anywhere. 

Update software automatically and reduce maintenance costs. 

Storage capacity depends on cloud computing service providers. 

There are challenges of using cloud computing in education, 

including: 

Information Security. 

The performance. 

Accuracy and reliability. 
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